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Gym 
A gymnasium, also known as a gym, is a covered location for athletics. The 

word is derived from the ancient Greek term "gymnasium". They are commonly found 

in athletic and fitness centres, and as activity and learning spaces in educational 

institutions. "Gym" is also slang for "fitness centre", which is often an area for indoor 

recreation. A "gym" may include or describe adjacent open air areas as well. In 

Western countries, "gyms" (or pl: gymnasia") often describe places with indoor or 

outdoor courts for basketball, hockey, tennis, boxing or wrestling, and 

with equipment and machines used for physical development training, or to do 

exercises. In many European countries, Gymnasium (and variations of the word) also 

can describe a secondary school that prepares students for higher education at 

a university, with or without the presence of athletic courts, fields, or equipment. 

Overview  

Gymnasia apparatus like barbells, jumping board, running path, tennis-balls, cricket 
field, and fencing area are used as exercises. In safe weather, outdoor locations are 
the most conducive to health. Gyms were popular in ancient Greece. Their curricula 
included self-defense, gymnastica medica, or physical therapy to help the sick and 
injured, and for physical fitness and sports, from boxing to dancing to skipping rope. 

History 

The first recorded gymnasiums date back to over 3000 years ago in ancient Persia, 

where they were known as zurkhaneh, areas that encouraged physical fitness. The 

larger Roman Baths often had attached fitness facilities, the baths themselves 

sometimes being decorated with mosaics of local champions of sport. Gyms 

in Germany were an outgrowth of the Turnplatz, an outdoor space for gymnastics 

founded by German educator Friedrich Jahn in 1811 and later promoted by 

the Turners, a nineteenth-century political and gymnastic movement. The first 

American to open a public gym in the United States using Jahn's model was John 

Neal of Portland, Maine in 1827. The first indoor gymnasium in Germany was probably 

the one built in Hesse in 1852 by Adolph Spiess. 
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Health center   

College health-service programs provide low-cost, primary medical care for students on college 

campuses, college students received primary health care from campus health programs. Just as modern 

medicine has changed, so too has the scope of services college health centers provide. Medical 

developments allow for most injuries and illnesses to be treated by ambulatory clinics, and this same 

trend is seen in most college health centers. Health centers often provide care for acute illnesses and 

injuries on an outpatient basis, while also meeting the needs of students with continued and chronic 

illnesses and providing wellness education to the campus community. 

In addition to meeting the basic and most common needs of the students they serve, campus health-

service programs also act as referral agents for students to connect with medical providers, as needed, 

in the local community. College health services are continually evolving and changing in order to best 

provide treatment and education for the campuses they serve. 

 

  Health center  conducted  various  health awareness programmes such as 

 RED RIBBON AWARENESS PROGRAMME, 

 AIDS AWARENESS PROGRAMME, 

 COVID-19 VACCINATON, 

 World Cancer day, 

 National deworming day, 

 World health day, 

 World malaria day 
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LMS CLASSES CONDUCTED TO II B.Sc students 

Lecture: Dr. G.SRINIVASULU, Lecturer in Chemistry 

Chapter name: Electro Chemistry 
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VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                        (Accredited by NAAC “B” Grade) 

   (An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

        DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                Date: 21 -07-2022 

Course: II B.Sc.,MPCs Time: 11 to 12 noon 

Topic : INSTALLING JAVA  

Number of Students Attended: 24 
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                       DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                          Date:   -07-2022 

Course: II B.Sc., MPCS           Time: 03 to 04 PM 

Topic: CREATING E-MAIL 

Number of Students Attended: 24 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
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(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

             DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                Date:    -07-2022 

Course: II BSc MPCs Time: 11 to 12 noon 

Topic: DIGITAL TECHNOLOGIES 

Number of Students Attended: 24 
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                        DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                Date:   -07-2022 

Course: II B.Sc., MPCs Time: 11 to 12 noon 

Topic: INTERNET OF THINGS 

Number of Students Attended: 24 

 

 

 

 

 

 

 

 

 

 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                     (Accredited by NAAC “B” Grade) 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                          Date:      -08-2022 

Course: II B.Sc., MPCS          Time: 02 to 03 PM 

Topic: JAVA CONCEPTS 

Number of Students Attended: 10 
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                                             (Accredited by NAAC “B” Grade 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                          Date:    -08-2022 

Course: II B.Sc,, MPCs          Time: 11 to 12 noon 

Topic: IOT 

Number of Students Attended: 24 
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                           DEPARTMENT OF COMPUTERS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Sri.CH.VIJAYA KUMAR                          Date:    -08-2022 

Course: II BSc., MPCs          Time: 11 to 12 noon 

Topic: INTERNET OF THINGS 

Number of Students Attended: 24 
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VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                        (Accredited by NAAC “B” Grade) 

   (An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

             DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 21-07-2022 

Course: II BSc, MPC & MPCs Time: 11 to 12 noon 

Topic: CR Circuit 

Number of Students Attended: 32 

 

 
 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
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(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

                       DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 22-07-2022 

Course: II BSc, MPC & MPCs Time: 03 to 04 PM 

Topic: LCR Series Circuit 

Number of Students Attended: 31 

 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                   (Accredited by NAAC “B” Grade) 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

             DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 27-07-2022 

Course: II BSc, MPC & MPCs Time: 11 to 12 noon 

Topic: Quality factor 

Number of Students Attended: 29 

 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                         (Accredited by NAAC “B” Grade) 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

                        DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 28-07-2022 

Course: II BSc, MPC & MPCs Time: 11 to 12 noon 

Topic: Power in ac circuits 

Number of Students Attended: 28 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                     (Accredited by NAAC “B” Grade) 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 02-08-2022 

Course: II BSc, MPC & MPCs Time: 02 to 03 PM 

Topic: Maxwell equations 

Number of Students Attended: 29 

 

 

 



VKV GOVT DEGREE COLLEGE, KOTHAPETA 
                                             (Accredited by NAAC “B” Grade 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 03-08-2022 

Course: II BSc, MPC & MPCs Time: 11 to 12 noon 

Topic: Electromagnetic wave equation 

Number of Students Attended: 30 
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                                       (Accredited by NAAC “B” Grade) 

(An ISO 9001:2015 Certified College by HYM International Certifications Pvt. Ltd.) 

                           DEPARTMENT OF PHYSICS 
ICT Class Teaching 2021-22 

    

Name of the Faculty: Dr. K. Ankama Rao                          Date: 04-08-2022 

Course: II BSc, MPC & MPCs Time: 11 to 12 noon 

Topic: Poynting Theorem 

Number of Students Attended: 26 

 

 



DEPARTMENT OF ECONOMICS 

PPT PRESENTATION-1 
 PowerPoint can be an effective tool to present material in the classroom and encourage student learning. 

 An education-based PowerPoint presentation templates have become an integral part of teaching in today’s classrooms. They provide 

educators with a versatile tool for delivering engaging and interactive lessons. PPT presentations also offer numerous benefits for students, 

including the ability to improve concentration and comprehension levels. 

 Additionally, by using PowerPoint slides in conjunction with other instructional materials, such as textbooks and handouts, teachers can 

ensure that all 

students are able 

to access the 

information 

being presented 

in class. PowerPoint 

presentations 

can be a powerful 

tool for teaching 

and learning when 

used effectively. 



 The main reason behind it is that PowerPoint presentations enable you to interact with your audience psychologically. So, here we’re going to 

discuss the power of PowerPoint in education. 

 

 

 

 

 

 

 

 

 

 

 

The department of 

economics in 

VKV Government 

degree College, 

kothapeta was 

taught the topic “NITI Aayog” through PPT on 4-09-2021 for I B A students to aware the students about NITI Ayog by  Smt.T. 

Ramadevi, lecturer in economics. 

NITI Ayog: 

The NITI Aayog (lit. Policy Commission; abbreviation for National Institution for Transforming India) serves as the apex public policy think tank 

of the Government of India, and the nodal agency tasked with catalyzing economic development, and fostering cooperative federalism through the 

involvement of State Governments of India in the economic policy-making process using a bottom-up approach. 



Objectives of NITI Ayog: 

 To evolve a shared vision of national development priorities, sectors and strategies with the active involvement of States. 

 To foster cooperative federalism through structured support initiatives and mechanisms with the States on a continuous basis, recognizing 

that strong States make a strong nation. 

 

FUNCTIONS OF NITI AYOG 

 

1. Cooperative and Competitive Federalism 

2. Shared National Agenda 

3. State’s Best Friend at the Centre 

4. Vision & Scenario Planning 

5. Network of Expertise 

6. Domain Strategies 

7. Knowledge and Innovation hub 

8. Harmonization 



 

POWER POINT PRESENTATION: 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 



DEPARTMENT OF ECONOMICS 

PPT PRESENTATION-2 
 PowerPoint can be an effective tool to present material in the classroom and encourage student learning. 

 An education-based PowerPoint presentation templates have become an integral part of teaching in today’s classrooms. They provide 

educators with a versatile tool for delivering engaging and interactive lessons. PPT presentations also offer numerous benefits for students, 

including the ability to improve concentration and comprehension levels. 



 Additionally, by using PowerPoint slides in conjunction with other instructional materials, such as textbooks and handouts, teachers can 

ensure that all students are able to access the information being presented in class. PowerPoint presentations can be a powerful tool for 

teaching and learning when used effectively. 

 The main reason behind it is that PowerPoint presentations enable you to interact with your audience psychologically. So, here we’re going to 

discuss the power of PowerPoint in education. 

 

 

 

 

 

 

 

 

 

 



The department of economics in VKV Government degree College, kothapeta was taught the topic “NITI Aayog” through 

PPT on 12-09-2021 for II B A students to aware the students about ARICULTURAL MARKETING by  Smt.T. Ramadevi, lecturer 

in economics. 

AGRICULTURAL MARKETING: 

Agricultural marketing is a method that includes gathering, storage, preparation, shipping, and delivery of different farming materials across the country. In agriculture 

marketing, the selling of an agriculture product depends on various components like the demand for the product at that time, availability of storage, etc. 

Before Independence, farmers while selling their products to traders experienced massive incorrect weighing and manipulation of accounts. The farmers did not have required 

information about the prices and were forced to sell at low prices with no proper storage facility. 

Sometimes, the product could be sold at a weekly village market in the farmer’s village or in a neighbouring village. If these shops are not available, then the product is sold at 

irregular markets in a nearby village or town, or in the mandi. So, the government took various measures to control the activities of the traders. 

The four Government Measures to Improve Agriculture Marketing 

 The initial step was to regulate the market and plan a clean, transparent and simple marketing strategy. This regulation helped both the farmers and the 

consumer. But it still needs to realize the full potential of rural markets. 

 The second measure was the procurement process like transportation facilities, warehouse, cold storage, godowns, and the processing unit. However, the 

current infrastructure is inadequate to adhere to the growing demand and therefore needs to be improved. 

 The third aspect is to decide on the fair price for the product. In the past, it has been a set back due to the unequal coverage of farmer members and the 

absence of a suitable link between marketing, processing cooperatives, and inefficient financial management. Example of a successful cooperative is the Gujarat 

milk cooperative which transformed the social and economic landscape of Gujarat. 

 The last one is policies such as. 

1. Guarantee of Minimum Support Prices (MSP) for agricultural products 

2. Storage of surplus stocks of wheat and rice by Food Corporation of India (FCI) 

3. Distribution of food staples and sugar through PDS 

All these measures were penned down to guard the income of the farmers and procuring agriculture products in the subsidized rate to the underprivileged. However, 

in spite of government interference in agriculture marketing, private traders still dominate the agricultural markets. 

 

POWER POINT PRESENTATION: 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



DEPARTMENT OF ECONOMICS 

PPT PRESENTATION-3 
 PowerPoint can be an effective tool to present material in the classroom and encourage student learning. 

 An education-based PowerPoint presentation templates have become an integral part of teaching in today’s classrooms. They provide 

educators with a versatile tool for delivering engaging and interactive lessons. PPT presentations also offer numerous benefits for students, 

including the 

ability to improve 

concentration 

and 

comprehension levels. 



 Additionally, by using PowerPoint slides in conjunction with other instructional materials, such as textbooks and handouts, teachers can 

ensure that all students are able to access the information being presented in class. PowerPoint presentations can be a powerful tool for 

teaching and learning when used effectively. 

 The main reason behind it is that PowerPoint presentations enable you to interact with your audience psychologically. So, here we’re going to 

discuss the power of PowerPoint in education. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The 

department of economics in VKV Government degree College, kothapeta was taught the topic “NITI Aayog” through PPT on 



17-10-2021 for I B A students to aware the students about ARICULTURAL MARKETING by  Smt.T. Ramadevi, lecturer in 

economics. 

BUSINESS CYCLES: 

 

A business cycle is a period that describes the natural ebbs and flows within an economy. The term “business cycle” can be used to 

describe both economic expansions and recessions. Generally, what we know is that a recession starts with a decline in production and 

sales levels. This decline usually lasts for 18 months or more before it reverses again into an expansion phase where production and sales 

increase once again. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Business Cycle Phases with Graph 

A country keeps track of the trade cycle to ensure that the economy is on the path of growth, unemployment steeps 

down, and the inflation rate remains under control. To understand the economic fluctuations and pattern, let us have 

a look at the following graph: 
 

1. Expansion: When a nation’s GDP shows an upward move or recovers with time, this period of growth is 

remarked as economic expansion. During this phase, the various economic indicators like consumer spending, 

income, demand, supply, employment, output, and business returns shoot up. 

2. Peak: During the expansion phase, the GDP spikes to its highest level; this is considered the economy’s peak. At 

this point, economic factors like income, consumer spending, and employment level remain constant. 

3. Contraction: Next comes the phase of economic slowdown; it occurs when the stagnant peak GDP starts 

tumbling down towards the trough. With this, the nation’s production, employment level, demand, supply, 

income level, and other economic parameters plummet. 

4. Trough: This is the stage at which the GDP and other economic indicators are at their lowest. During this phase, 

the economy gets stuck at a negative growth rate. Additionally, the demand for goods and services reduces. 

 

 

 

 

 

 

 

https://www.wallstreetmojo.com/rate-of-inflation-formula/
https://www.wallstreetmojo.com/gross-domestic-product-gdp/
https://www.wallstreetmojo.com/top-10-economic-indicators-watch/
https://www.wallstreetmojo.com/economic-factors/
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LECTURERS : 

1. Sri.N.Nageswara Rao,Lecturer & H.O.D. in Botany 
2. Kum.CH.Jayasi,Lect.in Botany 
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: : INAUGURATION OF CERTIFICATE COURSE : : 

 
“OFFICE AUTOMATION AND WEB TOOLS” 

 
                    COURSE STARTED DATE: 13TH JULY,2022 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

DEPARTMENT OF COMPUTERS 

 

Our Students falicitating Our Hon’ble Principal,Dr.K.Peddi Raju Sir 

 

Our Hon’ble Vice-Principal Sir,Sri.S.Aruna Kumar Sir delivering his speech 

 

Sri.Ch.Vijaya Kumar,Lect.in Computers 
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Our Hon’ble Principal Sir delivering his speech about the Course 

Our Hon’ble H.O.D. in Commerce ,Dr.K.Satyanarayana Sir delivering his speech 

Our Hon’ble H.O.D. in Chemistry,Dr.G.Srinivasa Rao Sir giving his speech 

Our hon’ble English Lecturer Smt.Naga Deepika garu giving her speech 

Our Hon’ble Lecturer in Political Science giving her speech 
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DAILY TRAINING / PRACTICE SESSION OF THE COURSE : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Thank you 
 

 

Our Hon’ble Lecturer in History,Ms.Ch.Bhavani madam giving her speech 
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SAMPLE COPIES OF SIGNATURES OF THE STUDENTS 
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Office Automation and Web Tools 

SCHEME OF EXAMINATION (Practical Type) 
 
 

 
TEST 

Duration 
(Minutes) 

Maximum 
Marks 

Minimum qualifying 
marks 

Office Automation and 
Web Tools 
 

 
60 

 
100 

 
30 

 
SYLLABUS 

 

The test shall comprise the following five parts: 
 

Name of 
the part 

Name of the Question to be answered Marks 

Part A 
Example: Typing a letter/passage/paragraph ( about 100- 
150 words ) in MS-Word 

30 

Part B Example: Preparation of a Table/Graph in MS-Excel 20 

Part C Example: Preparation of Power Point Presentations/Slides 
(Two) on MS-Power Point. 

20 

Part D Example: Creation and manipulation of data bases. 20 

Part E Example: Displaying the content of E-mail (Inbox). 10 

Total 100 

 
Note: The candidates shall be given the text / matter in the Question Paper and they must 
type / reproduce it in the Answer Sheet. The formatting of the text should also be of the 
same type as given in the Question Paper. 
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NAME 

 
CONTENTS OF PART-A 

 
MARKS 

 
 
 
 
 
 
 
 
 
 
 
 
 
WORD 

1. Create and save a document using MSWORD 

a. Deletion of Character, Word, line and block of text 
b. Undo and redo process 
c. Moving, Copying and renaming 

2. Format the Text document 
a. Character formatting 
b. Paragraph formatting 
c. Page formatting 

3. Spell check the document 
a. Finding and Replacing of text 
b. Bookmarks and Searching for a Bookmarks 
c. Checking Spelling and Grammar automatically 
d. Checking Spelling and Grammar using Dictionary 

4. Print the document 
a. Print Preview 
b. Print Dialog box 

5. Mail Merge in Ms-word 

a. Create main document and data file for mail merging 
b. Merging the files 
c. From letters using mail merging 
d. Mailing labels using mail merging 

6. Table creation in Ms-word 

a. Create a table in the document 
b. Add row, column to a table 
c. Changing column width and row height. 
d. Merge, split cells of table. 
e. Use formulae in tables. 
f. Sorting data in a table. 
g. Formatting a table. 

7. Ability to type on Qwerty key board of Computer at a speed 
of at least equivalent to 30 Words per 1 minute (Lower type 
writing test). 

 
 
 
 
 
 
 
 
 
 
 
 

30 

NAME CONTENTS OF PART-B MARKS 

 
 
EXCEL 

1. Create and save a new work book in Excel 
2. Entering Data into Work sheet 
3. Editing data of Worksheet 
4. Formatting the text in the cells 
5. Formatting the numbers in the cells. 
6. Formatting cells. 
7. Copying format of cell along with data format. 
8. Changing the height and width of cells. 
9. Freezing Titles, splitting screen 
10. Enter formulae for calculation in the cells. 
11. Copying the formula over a range of cells. 
12. Inserting built-in functions in to the cells. 
13. Create graphs for the data using ChartWizard. 
14. Format graphs in Excel. 
15. Printing of work sheet. 

 
 
20 
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NAME CONTENTS OF PART-C MARKS 

 
 
 
 

POWER 
POINT 

1. Create and save a new presentation using MS Power 
Point 

 layout of opening screen in PowerPoint 

 the tool bars in MS PowerPoint 
2. Choose Auto Layout for a new slide. 

3. Insert text and pictures into a blank slide. 

4. Insert new slides into the presentation. 

5. Apply slide transition effects. 

6. Slide show. 

7. Set animation to text and pictures in a slide 

8. Set the sounds, order and timing for animation. 

 
 
 
 

20 

NAME CONTENTS OF PART-D MARKS 

ACCESS Creation and manipulation of data bases 20 

NAME CONTENTS OF PART-E MARKS 

 
 

 
INTERNET 

1. Browse the Net using Browser software (Internet 
Explorer, Mozilla Firefox, Google Chrome etc.,). 

2. Search the Web using Search Engines. 
3. Create an E-mail account. 
4. Send and receive E-mail. 
5. E-commerce transactions. 

6. Web content up loading. 
7. Ability to operate Mac OS / pages / key note/ 

Numbers. 

 
 

 
10 

GRAND TOTAL 100 
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OFFICE AUTOMATION AND WEB TOOLS 
STUDY MATERIAL 

 
 

Task-1 
Visiting Card 

1. Create a Visiting Card of your college using page size as follows 

 Page width=”3.2” 

 Page height=”2.2” 

And use different font styles, sizes, alignments. 

Procedure: 

Step 1: Open MS-Word by click on START button; go to All Programs, then select Microsoft Office Word 

2007. 

Step 2: To open a new document, Click on Office Button then select New - > Blank Document then click on 

create option. 

Step 3: Now click on “Page Layout” from the Menu bar. Then click on Margins then click on Custom 

Margins option. Then the “Page Setup” dialog box appears. In this you find three tabs namely “Margins”, 

”Paper”, ”Layout”. Then in the ‘Margins’ tab, make all the parameters like Top, Bottom, Left, Right, and 

Gutter to zero and make Gutter Position to Left. Then in the Page tab, change the width and height options 

to 3.2 and 2 respectively. Then in the Layout tab, make the Header and Footer to zero. Now this page is set 

to the visiting card as follows. 

 

Step 4: In this step we have to enter the telephone number and Fax number on the top part of the paper. It 

can be done as follows: 

 First go to Insert menu, then select Symbol option. 

 Then change Font to “Windings”. 

 Then select the appropriate to your need i.e., to the telephone option select , and to the Fax 

option select . 

Step 5: Now write your institution name and make it to the center alignment button . 

Step 6: Now write all the details you want to put in your visiting card as your needs. And select the text and 

make it to center . 

Step 7: Now change the background color by selecting Page color option from Page Layout menu. 
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Step 8: This is the final step in creating Visiting Card. In this step, we have to save the letter as “Visiting 

Card.docx” by selecting “Save” option from Office button. Then a prompt window will ask you to write a 

file name. Now you have to give the file name and press the save button. 

OUTPUT: 

                                          

 

 

 

 

 

****************************************************************************** 

Task-2 

LEAVE LETTER 

Aim: Write a leave letter to the Principal by using different alignments, correct formats in MS Word. 

Procedure: 

Step 1: Open MS-Word by click on START button; go to All Programs, then select Microsoft Office Word 

2007. 

Step 2: To open a new document, Click on Office Button then select New - > Blank Document then click on 

create option. 

Step 3: Then select TEXT AREA, and then write Leave Letter as a heading, Select the text, click on bold 

button to make it bold as “LEAVE LETTER”, and change the font size to 16. 

Step 4: Then write date and place in a format as follows 

DATE: 19/10/2015, 

Bhimavaram. 

Then Select the text and make it right by clicking on right alignment button  

Step 5: Then write To address as follows and select this text and make it left by clicking on left alignment 

button  

To 

The Principal, 
B V Raju College, 
Vishnupur, 
Bhimavaram. 
Step 6: Then write Subject according to your letter. And select this text and press tab button for two times. 

Step 7: Then write the body of the letter according to your letter. And select this text and make it  

 

VKV GDC – KOTHAPETA 
                                       :08855243440 

                                              : 88552-43-440 
___________________________________ 
 
___________________________________________ 
ADDRESS : 
KOWSHIK ROAD 
KOTHAPETA 
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justification by clicking on justify alignment button  

Step 8: Then write “Thanking you Sir,” select this text and make it to center by clicking on center alignment 

button  

Step 9: Now write the “From address” as follows 

Yours Faithfully, 

T.Rambabu. 

Then make it right by clicking on Right alignment button  

Step 10: This is the final step in writing leave letter. In this step, we have to save the letter as “leave 

letter.docx” by selecting “Save” option from Office button. Then a prompt window will ask you to write a 

file name. Now you have to give the file name and press the save button. 

 

OUTPUT : 

                                                                 Date:, 

Bhimavaram. 

To 

   The Principal, 

   B V Raju College, 

   Palivela, 

   Kothapeta. 

Sub: Requesting for 5 days leave-Reg 

Respected Sir, 

                       I T.Shirisha studying B.Tech I year in IT department in your college. As I am going to my 

home on the occasion of Ugadi festival and also to celebrate my birthday on the next day.So I kindly request 

you to grant me leave for 5 days i.e.,24/3/2012-28/3/2012. 

Thanking You Sir, 

Yours Faithfully, 

T.Rambabu, 

B.Sc, I year. 

 

****************************************************************************** 
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Task-3 

Mail-Merge in MS-Word 

 

To get started: 

 

 

 

 

 

 

 

 

 Click on the Mailings tab, then the Start Mail Merge button, and then Step by Step Mail Merge 

Wizard… 

 

 

 

 

 

 The wizard will open in the task pane to the right. Select your 

document type.  

 

 

 

To create the letters 

Step 1:  Select Document Type 

1. Select Letters from the Mail Merge task pane and click on next to start the document. 

2. Click Next: Starting document 

 

Step 2: Starting Document 

1. Click Use the Current Document under Select starting document  

2. Click Next: Select recipients 
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Step 3: Select reciepents 

The recipients can come from either an existing Excel file, or Access table or you can create a new list. 

 

If Using an Existing List:  

1. Click Use an existing list under Select recipients 

2. Click Browse  

3. Select the file 

4. Click Open Mail Merge Recipients opens showing the names and addresses from your file  

5. Click OK 

 

6. Click Next: Write your letter 

To Type a New List:  

 Click Type a new list under Select recipients  

 2) Click Create  

 Click Customize Columns to modify the list of fields 
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 Delete any unnecessary field names and/or add new ones  

 Click OK  

 Type records here hitting TAB to advance to the next field and to continue adding new records 

 Click OK  

 Click Save 

The recipients list will be saved as a separate file as a Microsoft Access file type. It is saved in the My Data 

Sources folder. It is recommended to save the file in this folder.  

 Click Next: Write your letter 

Step 4: Write your letter 

1) Click the location in your document where the data from the mail merge fields need to be 

inserted 

2) Insert the fields using Insert Merge Field from Mailings tab. 
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The field name will look like this: <<Name>> 

3) Repeat this step until all fields have been inserted. Remember to put spaces and punctuation 

where needed.  

4) Click Next: Preview your letters 

Step 5: Preview your letters 

 Here is where you can preview the first page with the fields filled in.  

 Click Next: Complete the merge  

Step 6: Complete the merge 

 To Complete the Merge:  

 Click Print to send directly to the printer  

 Click Edit individual letters to create a new file 

 

OUTPUT: 

D:20/07/2022, 

Karimnagar. 

To, 

Gopinath, 

xxxxxxxxxx, 

James Street, 

Kurnool, 

Kurnool. 

Dear Gopinath, 

  Hai! How are you? Am fine here. How are your studies going on? What about the mid 

exams. Am happy to say that our college has conducted FRESHERS PARTY for us in the last week at our 

college premises.Many competitions such as sports, food competition and funny games were conducted 

before the Fresher’s Day. We enjoyed a lot up to the last second of the party and our college has provided 

food and transportation facility also. Ok bye and “ALL THE BEST” for your exams. 
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Yours Lovingly, 

A.Ravi kum ar. 

 

Dt:20/07/2022 

Karimnagar. 

To, 

Shiva, 

yyyyyyyyyy, 

Geetha Bhavan, 

Karimnagar, 

Karimnagar. 

Dear Shiva, 

  Hai! How are you? Am fine here. How are your studies going on? What about the mid 

exams. Am happy to say that our college has conducted FRESHERS PARTY for us in the last week at our 

college premises. Many competitions such as sports, food competition and funny games were conducted 

before the Fresher’s Day. We enjoyed a lot up to the last second of the party and our college has provided 

food and transportation facility also. Ok bye and “ALL THE BEST” for your exams. 

Yours Lovingly, 

A.Ravi Kumar. 

D:20/05/2012, 

karimnagar. 

To, 

Shilpa, 

zzzzzzzzzzz, 

Thimmapur, 

Karimnagar, 

Karimnagar. 

Dear Shilpa, 

        Hai! How are you? Am fine here. How are your studies going on? What about the mid exams. 
Am happy to say that our college has conducted FRESHERS PARTY for us in the last week at our college 
premises.Many competitions such as sports, food competition and funny games were conducted before the 
Fresher’s Day. We enjoyed a lot up to the last second of the party and our college has provided food and 
transportation facility also. Ok bye and “ALL THE BEST” for your exams. 
 

Yours lovingly, 

A. Ravi Kumar 

****************************************************************************** 
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MS Excel 2007 
Task-1 
Charts 

1. Create an electronic spread sheet which shows the sales of different products for 5 years.  

Create column chart for the following data 

Year Product_1 Product_2 Product_3 Product_4 

2010 1000 800 900 1000 

2011 800 80 500 900 

2012 1200 190 400 800 

2013 400 200 300 1000 

2014 1800 400 400 1200 

 

Creating the spread with different products of 5 year 

 Before you can make a chart, you must first enter data into a worksheet. To create the spread sheet 

with 5 years different products follow the below steps 

Step1:  

 Click on the cell B1 and type “Product_1” and go to the next cell by clicking the Tab key on the 

keyboard. 

Step 2:  

 In the cell C1 type “Product_2” and click on tab key to activate next cell. Repeat the above to steps 

to enter “Product_3”, “Product_4” 

Step3:  

 Click on cell “A2” and type “2010” then press on tab key to activate the next cell. 

Step 4:  

 Repeat the above procedure to enter the details of four products for five years. Finally we have the 

data of products as follows 

 

Creating a Column chart for the above data 

Definition of Chart:  

 Charts allow you to present data entered into the worksheet in a visual format using a variety of 

graph types.  
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Following steps are given to draw a Chart  

1. Enter data in the work sheet: Suppose you entered data as given in below 

 

2. Now select data range: By using the mouse high light the range of data you want to take  

 

3. Click Insert Tab and select a chart type from the chart group and Select the sub type of chart ( In this 

example selected a 2D Column chart) 

 

4. The Chart will be displayed as follows 

 

5. Select the Title of the chart 

 To give a title to a chart, click on the chart. Now you can see layout tab available. Click on 

Layout tab.  
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 Choose(click) on chart title option available in the Label group 

 Click on the chart title and write a title “Product Analysis”. 

 

 

6. Give a name to X-Axis  

 Click on Layout tab.  

 Then select Axis Titles from Labels Group.  

 Select Primary Horizontal Axis Title, as shown below. 

 Now, click on the Axis Title and write an X-axis title “Year”. 

 Follow the same steps to give a title to Y-axis “Product Sales”. 

 

 

7. Adding Data Labels to the chart 
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 Click on Layout tab. 

 Then click on Data Label option available in Labels Group.  

 Now choose a format to display data labels 

 

Output: 

 

 

****************************************************************************** 
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Task-2 

Grade of a Student 

2. Create a suitable examination data base and find the sum of the marks(total) of each Student 

and respective class secured by the student  

Rules 

 Pass if marks in each subject > = 35,  

 Distinction if average>=70,  

 First class if average>=60 but <70,  

 Second class if average >=50 but <60,  

 Third class if average>=35 and but <50 ,  

 Fail if marks in any subject is <35 .  

Display average marks of the class, subject wise and pass percentage 

Solution: 

To find the grade of a student we need to follow the following steps 

 

Step 1: Typing Student database in Excel 2007 

Type the student database with the required fields starts from A1 cell as follows 

 

 

Step 2: To find Total Marks of Student 

To find the total marks of a student click on the cell “G2” and type the following formula 

 

To find the total marks for the remaining students select “G2” cell and drag down to the remaining 

students. 
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Step 3: To find Average marks 

To find the average marks of the student click on the cell “H2” and type the following formula 

 

To find the average marks for the remaining students select “H2” cell and drag down to the all the 

students. 

 

Step4: To Check Pass or Fail 

To check whether the student is Pass or Fail select the cell “I2” and type the following formula 

 

To check the remaining students are Pass/Fail select the cell “I2” and drag down to all the students 

 

Step 5: To find Grade 

To find the grade of a student click on the cell “J2” and type the following formula 
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To find the grade for the remaining students select “J2” cell and drag down to the all the students 

 

Finally we get the following student database with total, average and grade  

 

Output: 

 

****************************************************************************** 
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Microsoft Power Point 2007 

Task-1 

Creating Power Point Presentation for I year Subjects 

1. Make a Power point presentation of all the details of the books that you had studied in B.Sc. 

First Year. 

 PowerPoint is presentation software that can be used to create slide shows for printing, on-screen 

projection, or Web-based display. 

Opening PowerPoint 

NOTE: The procedure for opening PowerPoint may vary depending on the setup of your computer. 

To open PowerPoint in Windows, click on the 

Start button --> Programs --> Microsoft PowerPoint        

 When PowerPoint 2007 is opened, a blank Title slide appears by default as the first slide in your 

new presentation. You can start a new presentation when you first open PowerPoint or after PowerPoint is 

already open. 

To change the layout of an open slide, click on the Layout button in the Home tab. 

 

 

Inserting Slides 

There are two ways to add new slides to your presentation.  

 Quick Menu Option 

 Ribbon Option 

 

Quick Menu Options 

 To insert a new slide using the Quick Menu, in the Slides panel right click the slide after which you 

want a new slide inserted and select New Slide. 



 

 To change the layout of the slide,

select the desired theme. 

 Ribbon Option 

 From the Home tab in the Slides grou

active slide. 

 If you wish to choose the layout while creating your new slide, click the

and choose a theme. 

Select the new slide from Quick menu option or Ribbon 

 

 

 

 

To change the layout of the slide, right click the new slide in the Slides panel, select

in the Slides group, click on New Slide. A blank slide will be inserted after your 

 

If you wish to choose the layout while creating your new slide, click the 

Select the new slide from Quick menu option or Ribbon Option: 

2
4 

the new slide in the Slides panel, select Layout and 

. A blank slide will be inserted after your 

 on the New Slide button 
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Apply a new layout to a slide 

To change the layout of an existing slide, do the following: 

1. On the Slides tab, click the slide that you want to apply a new layout to. 

2. On the Home tab, in the Slides group, click Layout, and then click the new layout that you want. 

Copy a slide 

To copy a slide does the following 

1. On the Slides tab, right-click the slide that you want to copy, and then click Copy on the shortcut 

menu. 

2. Still on the Slides tab, right-click where you want to add the new copy of the slide, and then 

click Paste on the shortcut menu. 

You can also insert a copy of a slide from one presentation into another presentation. 

Rearrange the order of slides 

 On the Slides tab, click the slide that you want to move, and then drag it to the location that you 

want. 

 To select multiple slides, click a slide that you want to move, and then press and hold CTRL while 

you click each of the other slides that you want to move. 

Delete a slide 

 On the Slides tab, right-click the slide that you want to delete, and then click Delete Slide on the 

shortcut menu. 

Adding text to a slide  

The Title Slide layout contains text boxes for a title and a subtitle. Try typing text into these boxes. 

1.  Click in the Title text box. A dashed line border with a circle in each corner and a square box at each 

midpoint appears around the text box indicating that it is selected. 

 

 Adding list of subjects that studying in B.Sc. First Year into the slides: 
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2.  Click the Subtitle text box and type a subtitle. 

Selecting a Theme or Designing Slides 

 Design themes are a convenient way to add a professional flair to your presentation. Themes include 

preset colors, fonts, backgrounds, and formatting effects. PowerPoint provides you with the option to 

customize one of their existing themes or to build your own. 

Selecting a Theme 

 To choose a Theme for an open slide, use the Theme group under the Design tab. Use the arrows 

on the right of the Theme group to scroll through the themes, or to see all available themes at once. When 

you hold your mouse over any of the examples, PowerPoint will show you a preview of the slide. 
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Animating Text and Images 

Adding Animation to Slides 

1. Click on the object or text box you wish to animate (hold down the Ctrl button while clicking to 

select more than one). 

2. In the Animations tab under the Animations group, select an option from the Animate pull-down 

list. As you move your mouse over each choice PowerPoint will preview the effect on your slide. 

3. Repeat for any other slides or objects you wish to animate. 

 

 

Run Your PowerPoint Slide Show 

After you create your slides, you can run your slide show: 

 Press F5. 

 Choose the Slide Show tab. Click the From Beginning button  in the Start Slide Show 

group. 

 Click the Slide Show icon in the bottom-right corner of your screen. 

 

Saving your presentation 

 If you are saving a document for the first time, you will need to use the Save As command; however, 

if you have already saved a presentation, you can use the Save command. 

To use the Save As command: 

 Click the Microsoft Office button. 

 Select Save As. A menu will appear. 

 Select the type of file you want to save the presentation as 

 Enter a name for the document. 

 Click the Save button. 

To use the Save command: 

 Click the Microsoft Office button. 

 Select Save from the menu. 

Using the Save command saves the document in its current location using the same file name. 

****************************************************************************** 
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MS-ACCESS 2007  

Task-1 

1. Create an Employee database with table Emp (Eno, Ename, Esal, Edept Eloc) and insert any 

five records. Create a report for the above Emp table of Employee database. 

 To open the MS-Access in windows ,click on  the start button programsMicrosoft Access. 

Create Access 2007 Employee Database 

 The first step in creating an Access 2007 database is to create a blank database file. This is done 

from the Getting Started Screen when you launch Access. The file is saved onto one of your PCs folders 

(which you specify). The procedure for doing this is outlined below. 

1. Launch Access 

 To begin, launch Access by clicking on the desktop icon, or choose Access from the start menu. This 

brings up the GETTING STARTED WITH MICROSOFT OFFICE ACCESS screen. 

2. Select Blank Database Template 

 

 Towards the top left of the screen you will see a "Blank Database" icon. Click this icon to bring up 

the Blank Database side bar on the right hand side of the screen. This is where you will enter details about 

the database file that you are about to create. 

3. Enter filename for your Access 2007 database (Employee) 

 

Begin by entering the name that you want to call the database in the filename textbox. 

4. Browse and select folder 

 Next click the folder icon and browse for a folder to put your database. Once selected you should see 

the file path below the textbox. 

5. Click Create 

 All you need to do now is click the "Create" command button below, and your database file saves to 

the location that you specified, and opens for you to work on. 

Creating an EMP Access 2007 Table 

A simple EMP Table 
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ENO ENAME ESAL EDEPT ELOC 

1 RAMA 8000 COMPUTERS BVRM 

2 KRISHNA 10000 MATHS ELR 

3 VIJAY 9000 SCIENCE AKVD 

 

Create Access 2007 EMP Table 

1. Open database file 

Open a blank Employee database file that you created earlier.  

2. Create Access EMP Table 

 Select the CREATE tab on the Access ribbon. Next select the TABLE DESIGN icon from the 

TABLES group. This creates a new table. 

 

 

3. Create fields in DESIGN VIEW 

 This brings up the TABLE DESIGN GRID where you enter each field name and its data type. The 

first field we are going to create is the ENO field which is going to contain a unique reference number for 

each record. Enter the name "ENO" into the first column of the first row in the grid. Because we want 

Access to automatically generate a unique reference number, select AUTONUMBER from the drop down 

list in the data type column. You can also enter a description for each field, but this is not essential. 

 On the next row the field is going to be called ENAME and the data type is going to be TEXT. On 

the third row the field name is EDEPT with the data type again being TEXT; next field name is ESAL with 

the data type NUMBER. And finally, the last field name is ELOC and the data type here is going to be 

TEXT.Before you save the table you will need to choose the Primary Key, which in this case is  

ENO. To do this, select the ENO row by clicking on it, and then simply click the primary key symbol on the 

Ribbon. 

 

The table design grid should now look like this: 
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 You can now save the table by clicking the save icon on the top left of the screen above the Access 

Ribbon. To view your table, select DATASHEET VIEW from the VIEWS group under the DESIGN TAB. 

This brings up the datasheet view of the table that you have just created. You should see your field headings 

running across the top of the table. 

 

4. Data entry in DATASHEET VIEW 

 Select the first cell in the ENAME column and enter the name RAMA. For ESAL enter 8000, and 

for EDEPT enter COMPUTERS and for ELOC enter BVRM. 

 You have now entered the first record in the table - record 1 for RAMA EDEPT :COMPUTERS . 

You can now press the return key and the record will save automatically. You are now ready to enter the 

second record on the next row - KRISHNA. Press return and then fill in the data for the last record we are 

going to do for now - VIJAY 

Your datasheet table should now look like this: 

 

 

Create Access 2007 Report for EMP table of Employee database 

Access Reports Present Data 

 Access REPORTS are a way of displaying and printing information from your database.  

 Like other Access database objects, there are number of ways to create an Access REPORT. We are 

going use the REPORT WIZARD. Our task is to display the records of EMP table which we created in the 

previous. 

1. Open Report Wizard 

 Begin by selecting the CREATE TAB on the Access Ribbon. Then click REPORT WIZARD from 

the REPORTS group to open the pop up window. 
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2. Select Report Data Source and Fields 

 The first page of the Report Wizard is almost identical to that of the Form Wizard. On this page we 

will select EMP as the DATA SOURCE for the Report. This is done by selecting the table  

 

from the list in the TABLES/QUERIES combo box. Then select all fields from Table:EMP  by clicking the 

double arrow to the right of the text box labeled AVAILABLE FIELDS. The field names will now appear in 

the SELECTED FIELDS text box on the right. Click next to go to the second page of the wizard. 

 

3. Report Grouping Levels 

 Page two of the wizard is where you can add grouping levels if required. So we could, for example, 

group each person in our report with others of the same age. We don’t need to do this for this particular 

example, but it is certainly a useful feature that we might want to learn more about later. But for now, just 

click next. 

4. Record Sort Order 

 Page three of the wizard is where you determine what order the records are displayed in your report. 

So for example you might want to display records in ascending order of Ename. For this example, however, 

we are going to put your records into ascending order. Begin by clicking the top drop down box and 

selecting Ename. This means that records are sorted alphabetically by Ename. 

Click Next 
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5. Report Lay Out 

 This page of the Wizard is where you set the lay out for your report. There are various lay out 

options, but in our case we shall keep to the default setting of TABULAR. 

Click next. 

6. Style 

For style, select Access 2007 from the list and click next. 

 

7. Name of Report 

Name your report EMPLOYEE_REPORT and then click FINISH.  

Your access report will now be displayed on the screen, and should look something like this: 
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INTERNET 
 
 

Web Browsing and Electronic Mail 

Web browsing 

 

 Browse means reading superficially or at random.
 

 Reading information contained in the WebPages on the Internet using browsers is called web 

browsing.

 A web browser is a software application for retrieving, presenting, and traversing information 

resources on the World Wide Web.

 
 

Understand the browsers 
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 In the address bar of the browser enter the address of the website or enter the address of the 

any search engine.

 If the address entered is a website then the corresponding webpage will get displayed.
 

 If the address entered is of a search engine (For example Google) then the webpage of the 

corresponding search engine will get displayed as shown below:

 In the search tab enter the information about your search. For example if you want to 

browse about computers enter the computers in the search tab.

 Then click Search tab.
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 A set of pages with the links to the webpages which contain information about computer as 

shown below:

 
 

 Clicking the links desired by you will be taking you to those webpages.
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Return to a Web Page That You Just Visited 
 

• To return to the last page you visited, click the Back button on the browser toolbar. 

• Click the Forward button to retrace your steps and return to pages you visited before you clicked 

the Back button. 

• To see one of the last nine pages you visited in this session, click the tiny black arrow to the right of 

the Back or Forward button, and then click the page you want from the list. 

 

Forward button on the Internet Explorer 6 toolbar 
 

Find a Web Page That You Visited Today or a Few Weeks Ago 

The browsers automatically records Web pages you've visited both today and in the past. It 

organizes them in folders on the History bar by the day you visited. Within each day, it 

organizes the Web sites alphabetically in folders, putting each page visited on that site in 

that folder. Here's how to find pages in the History list: 

 

1. On the Internet Explorer 6 toolbar, click the History button. 

Internet Explorer 6 opens the History bar on the left side of the screen. 
 

 

History button on the Internet Explorer 6 toolbar 

2. In the History bar, click the time period you want to search. For example, you may want to 

see all the sites you visited today. (Marked (2) as in the figure shown in Step 4.) 

3. Click the Web site folder to open the list of pages, and then click the link to the page to 
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 display the Web page itself. (Marked (3) as in the figure shown in Step 4.) 

4. 
 

 

History bar showing Web pages sorted by time period 

5. When you've finished using the History bar, click the Close button. 
 
 
 
 
 

Electronic Mail 

 Electronic mail, most commonly abbreviated email or e-mail, is a method of exchanging digital 

messages.

 E-mail systems are based on a store-and-forward model in which e-mail server computer 

systems accept, forward, deliver and store messages on behalf of users, who only need to 

connect to the e-mail infrastructure, typically an e-mail server.
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      Creating Email 
 
 

The users can have email account in any one of the email services such as gmail, 

yahoomail, rediffmail etc. 

To create an email account in any one these email services the user need to enter 

the address of the service in the browser first. 

The service will prompt the user to know whether a new user or not. 

If you are a new user then the service will guide step by step to create your own email id. 
 
 

Email Addresses 
 
 

Email addresses are made up of at least two parts. One part is the name of a mail 

domain that will ultimately translate to either the recipient's host or some host that 

accepts mail on behalf of the recipient. The other part is some form of unique user 

identification. Most e-mail addresses are set up like this: it is your username, then 

an @ ('at') symbol, and then a domain name (something .com, .net, or .org in most 

cases). 

Using Email 
 

Using e-mail is rather straightforward. Once you have an account set up, select the 

option that says something like "new e-mail message" or "create a new message". 

The service will prompt with three boxes (called fields): 

 
 To:

 Subject:

 Body

 Attachment
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To field: In the To field type the complete e-mail address of the person who will 

receive the e- mail. 

 
Subject and Body fields: Type anything you want in the subject and body fields, but 

remember the length of the subject is limited. 

 
Attachments: Click the Attach a file or Attachment link to add files to the message. 

 
Sending the message 

 
Once filling all the required fields and attaching files to the message click Send 

button to send the message. 

 
You can forward (make a copy) of a message you receive from someone (if you have 

their permission if necessary) and mail it to someone else with the forward option. 

 
CC and BCC 

 
CC stands for carbon copy. If you want to send a message to multiple people, add 

the extra people in the CC: field (usually you separate their e-mail addresses by 

commas). 

 
BCC stands for blind carbon copy. BCC works just like a carbon copy, except the e-

mail addresses you type in BCC do not show up to the other recipients. (Example: 

You send a message To: Mary and BCC: Joey. Joey will see Mary's e-mail 

address, but Mary won't see Joey's e-mail address because you "blinded" it by 

putting it in the BCC field.) 

CAUTION: You can also get viruses by downloading executable files (usually .com 

and .exe on Windows computers) from web sites. Don't download or run executable 

files from web sites you don't trust. 
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V.K.V.GOVERMENT DEGREE COLLEGE, KOTHAPETA 

 
OFFICE AUTOMATION AND WEB TOOLS –TEST 

 
 
Time: 2 Hrs. Max. Marks: 100 

PART A (Answer all questions) 
 
I Choose the correct answer (Each question carries 1 mark) 

 
1. What is the extension of word document? 

a).txts b).word c).docs d).docx 

2. Which command is used to display the content of the file abc in linux 

a) ls < abc b) dir > abc c) cat abc d) type abc 

3. Power point is a ……. software 

a) Word Processing software b) DBMS Package 
c) Presentation Software d) None of These 

4. A letter that appears little above the normal text is called --------- 

a) Superscript b)Subscript c) Supertext d).Toptext 

5. To open the Sort dialog box by choosing Sort from the ............... menu in Calc 

a) View b) Format c) Tools d)Data 

6. Which one is not a Function in MS Excel? 

a) SUM b)MAX c) AVG d) MIN 

7. Which of the following is an extension of the OpenOffice Calc? 
a).dos b) .sod c) .ods d) .calc 

8. To use the Slide Transition option by selecting it on the ........... menu in Impress 

a) Slide Show b) View c) Tools d) Format 

9. A formula in Calc is starting with ............... sign 

a)+ b) / c) = d) * 

10. The Change Case option in MSWORD contains …………… 

                               A ) Upper Case   b)Lower Case    c) Toggle Case d) All of these  

 

 

Fill in the blanks (Each question carries 2 marks)                     [10 x 1 = 10] 

 
11. The command used to create a directory in Linux is ………. 

12. Ctrl+S is the shortcut key for ................ in MSWORD 



 

 

13. The ……… application

14. In Excel, the

15. Table option

16. Subtotal is an 

17. An example

18. Bullet and Numbering

19. Mistakes can

20. ………. Function returns
 

 
II Answer any FIVE

 
1. Write down any

2. What is the

3. Write three

4. Write down

5. How to insert a

6. Briefly explain different

7. Briefly explain slide

8. Write any three
 

 
III Answer any FOUR

 
1. Explain how create an E

2. Explain any

3. What is mail

4. Explain any

5. Explain find

6. What is a Web browser? Explain about the various types of browsers?
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application contains information about computer

Excel, the intersection of row and column is known

option is appear in ............. ribbon tab in MSWORD

is an option of .................. ribbon tab in Excel

An example of logical function in Excel is ………. 

Numbering is appear in ................. menu

can be checked using .............. facility in Writer

Function returns current date in Calc. 

PART B 

FIVE questions from the following. 

down any three desktop icons in Windows and

the use of grep command in Linux and write

three cursor movement commands in vi editor

down the steps to insert a bullet and numbering

insert a table, rows and columns in a table in

explain different types of filters in MSEXCEL?

explain slide transition and custom animation in

three string functions in Calc and its use?

PART C 

FOUR questions from the following. (Each

Explain how create an E-Mail Account? 

any four applications in Windows Accessories

What is mail Merge? Write down the steps used in MSWORD?

any five mathematical functions in Excel? 

find and replace and headers and footers options

What is a Web browser? Explain about the various types of browsers?

                                                                                                                      

4
computer drives. 

known as ……… 

MSWORD 

in Excel 

menu in Impress 

in Writer 

 [10 x 2=20] 

 (Each question carries 6 marks)

and its use? 

write any four options? 

editor and its use? 

numbering option in MSWORD? 

in Writer? 

MSEXCEL? 

animation in MS PowerPoint? 

use? [5 x 6=30] 

following. (Each question carries 10 marks) 

Accessories group? 

MSWORD? 

options in Writer? 

What is a Web browser? Explain about the various types of browsers? [4 x 10=40] 
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6 marks) 
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LIST OF STUDENTS PARTICIPATED & LEARNED THE CERTIFIED COURSE :

NAME OF THE STUDENT GROUP SIGNATURE
IIBSC MPCS 

IIBSC MPCS 

 IIBSC MPCS 

K.LAKSHMI DURGA IIBSC MPCS 

IIBSC MPCS 

SANDHYA BHARGAVI IIBSC MPCS 

IIBSC MPCS 

IIBSC MPCS 

IIBSC MPCS 

IIBSC MPCS 

B.DURGA GANESH IIBSC MPCS 

AYYAPPA MANIKANTA IIBSC CHEMISTRY 

D.DHANALAKSHMI IIBSC MPCS 

P.DHANALAKSHMI IIBSC MPCS 

 IIBSC CHEMISTRY 

JONNADA RAKESH IIBSC CHEMISTRY 

IIBSC MPCS 

IIBSC MPCS 

KADALI SATYA SAI IIBSC MPCS 

 IIBSC MPCS 

SEELAM MEERA MOHAN IIBSC MPCS 

IIBSC MPCS 

 IIBSC HETTM 

IBSC MPCS 

IIBCOM GEN  
 IBSC MPCS 

K. SUVARNA RAJU IIBCOM CA  
IIBSC MPCS 

IIBCOM CA 

IIBCOM CA 
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MARKS AWARDED TO THE STUDENTS WHO LEARNED THE COURSE
 
SNO NAME OF THE 

STUDENT 
1 P.SUREKHA 
2 K.SUREKHA 
3 N.DIVYA JYOTHI 
4 K.LAKSHMI DURGA
5 DSL SANDHYA 
6 SANDHYA 

BHARGAVI 
7 K.AJAY 
8 M.AJAY 
9 BYRC PRASAD 
10 KJSR KRISHNA 
11 B.DURGA GANESH
12 AYYAPPA 

MANIKANTA 
13 D.DHANALAKSHMI
14 P.DHANALAKSHMI
15 KANAKA DURGA 
16 JONNADA RAKESH 

KUMAR 
17 CH  SATYA 
18 CH MAMATHA 
19 KADALI SATYA SAI
20 LAVA KUMAR 
21 SEELAM MEERA 

MOHAN 
22 BINDU MOULI 
23 KAGITHA VAMSI 
24 GOSANGI MAHESH
25 DHANUSH 
26 BASHEER 
27 K SUVARNA RAJU
28 P PUJITHA 
29 T VEERA BABU 
30 P DIWAKAR 
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MARKS AWARDED TO THE STUDENTS WHO LEARNED THE COURSE

GROUP MARKS SECURED

IIBSC MPCS 87 
IIBSC MPCS 89 

 IIBSC MPCS 86 
K.LAKSHMI DURGA IIBSC MPCS 87 

IIBSC MPCS 85 
IIBSC MPCS 83 

IIBSC MPCS 81 
IIBSC MPCS 80 
IIBSC MPCS 82 
IIBSC MPCS 79 

B.DURGA GANESH IIBSC MPCS 80 
IIBSC CHEMISTRY 80 

D.DHANALAKSHMI IIBSC MPCS 78 
P.DHANALAKSHMI IIBSC MPCS 76 

 IIBSC CHEMISTRY 79 
JONNADA RAKESH IIBSC CHEMISTRY 80 

IIBSC MPCS 65 
IIBSC MPCS 55 

KADALI SATYA SAI IIBSC MPCS 70 
IIBSC MPCS 72 
IIBSC MPCS 72 

IIBSC MPCS 79 
 IIBSC HETTM 77 

GOSANGI MAHESH IIBSC BA HEP 75 
IIBCOM GEN 74 
IIBCOM GEN 78 

K SUVARNA RAJU IIBCOM CA 77 
IIBSC MPCS 73 
IIBCOM CA 76 
IIBCOM CA 76 
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MARKS SECURED REMARKS 
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DEPARTMENT OF COMPUTERS 

STUDENT INDUCTION PROGRAM 

E-LEARNING RESOURCES, APPLICATIONS OF ICT, APPS 
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                                                                                                                TUESDAY 

 
Student Induction Program : 
 
   “  The Student Induction Program has been formulated with specific goals to help students to. Connect to 
the fundamental principles. See and respect other cultures, to see the commonalities among them in the 
light of clarity about human culture and civilization. Acquaint with the institution's ethos and culture”. 
 
    Student Induction Programme Purpose of Student Induction Programme is to help new students adjust 
and feel comfortable in the new environment, inculcate in them the ethos and culture of the institution, 
help them build bonds with other students and faculty members, and expose them to a sense of larger 
purpose and self exploration. The term induction is generally used to describe the whole process whereby 
the incumbents adjust to or acclimatize to their new roles and environment. In other words, it is a well 
planned event to educate the new entrants about the environment in a particular institution, and connect 
them with the people in it. Student Induction Programme engages with the new students as soon as they 
come into the institution; before regular classes start. At the start of the induction, the incumbents learn 
about the institutional policies, processes, practices, culture and values, and their mentor groups are 
formed. Students Induction could cover a number of different aspects (SAGE): Socializing: meeting other 
new students, senior students, students union, Lectures by Eminent People; Associating: visits to University 
/ college, visits to Dept./Branch/ Programme of study & important places on campus, local area, city and so 
on; Governing: rules and regulations, student support etc; 1 Experiencing: Subject lectures, study skills, 
small-group activities, physical activity, creative and performing arts, literary activities, universal human 
values, etc. 
 
    As a part of Student Induction Programme (SIP)  for newly admitted students of the year 2022-2023 an 
awareness programme was conducted through the Department of Computers, V.K.V.GOVT. DEGREE 
COLLEGE, KOTHAPETA on     dt. 08-11-2022 Tuesday at 3 pm to 5 pm. The theme of the programme which 
the lecturer organised is “E-LEARNING RESOURCES, APPLICATIONS OF ICT,APPS ”. The lecture was 
blended with interactive response of the resource persons as well as students. There are more than 50 
students are benefited by the programme. The lecture enlightened various approaches to connect with 
community how the students can use the online resources and applications in the society. The society 
needs help to get rid of evils like poverty, illiteracy  and everyone needs to concentrate these issues. The 
National Education Policy (NEP-2020) of India made and recome the scope of learning through community 
connect to how the students of HEI’s can add to the betterment of society. These changes in higher 
education pave the paths of better chances to students and make the global society and global harmony. 
These effective efforts by the implementation of NEP-2020 can have genuine influence on the holistic 
improvements the student community the integration of the concept connect with community can make a 
difference definitely among  



students life and society . 

The students gradually cultivate and incorporate the volunteer ship, help to local ,and start with small 
services camps through this awareness programme. The programme will help the students to enter in to 
the digital literacy using e-learning resources like digital libraries.  

Eg. Government Digital Libraries like National Digital Libraries(NDL) using online. 

    Information and Communication Technology (ICT) based teaching and learning plays a vital role in the 
digital literacy. We can present our lessons so simply using power point slide shows, video-conferences, 
online seminars. 

Use of ICT based Learning Tools The institute has been using ICT based learning tools since inception. The 
university provides the facilities of learning through ICT.  

Eg.  

a. In teaching learning process: LCD projectors, availability of course material on intranet for ready 
reference, Wi-Fi enabled campus; Online feedback system, conduct of webinars, usage of Virtual labs (as 
Nodal centre for Virtual Labs)  

b. In administration: Library, fee payment, admission, biometric employee attendance system, attendance 
monitoring of students. The University encourages that the ICT facilities are optimally utilized not only for 
the university system but also for being active part towards knowledge dissemination at national and 
international level and also for robust information security management. The institute is currently running 
a chapter of online courses of NPTEL. It is also moving towards developing course under SWAYAM. The 
university is encouraging courses run through MOOCs and NPTEL. The Library subscribes various softwares 
for accessing e- reading material, books and journals and has its own software for checking plagiarism. 

 etc.,This induction program told about the easy way of learning using internet. 

    There are many applications or apps related to the education available even in our daily used smart 
phones.We can learn anything by using that particular app. 

Eg. Python app,WPS-Office,Photoshop app,Programming Books,etc., 
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 Speech given By our Hon’ble Vice-Principal Sir, Sri.Aruna Kumar Sir  



 

 

 

 

 

 

 

 

 

                    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Speech given by our Hon’ble Sir, Sri.AnkamaKumar Sir ,H.O.D. in Physics 

Speech given by Hon’ble Guest Sri.J.Vidya Sagar,Lect. In Computers,  STBD College 

Speech given by Hon’ble Lecturer,Sri.G.Srinivasa Rao,H.O.D. in Chemistry 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Speech given by Hon’ble Lecturer,Sri.Sai Krishna Sir,Lect.in Chemistry 

Speech given by Hon’ble Lecturer,Sri.Sivaji,Lect.in Telugu 

 

Speech given by Hon’ble Lecturer,Sri.Ch.Moses Raju,Lect.in Computer Applications 



 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Speech given by Hon’ble Lecturer,Sri.D.C.H.Papa Rao, Lect.in Mathematics 

Speech given by Hon’ble Lecturer,Sri.Ch.Vijaya Kumar, Lect.in Computers 

 

Our Hon’ble Vice-Principal Sir, our Teaching Staff & Students are falicitating the 
Guest-Lecturer  



 

 

 

 

 

 

 

 

 

 

 

 

 

     Ultimately the programme enlightens the advantages of computer literacy and the usage of internet and 
the applications or so called apps and how they are useful to the global society. 

  

    We the Computer Faculties,  Sri.Ch.Vijaya Kumar and Sri.Ch.Moses Raju are so much thankful to Our 
Hon’ble Principal, Dr.K.Peddi Raju garu, Vice-Principal, Sri.S.Aruna Kumar garu  and all of the remaining 
Lecturers, Staff for their support in conducting this program.Blessings and Greetings to Our Students… 

 

THANK YOU 

 

2022 PASSED OUT STUDENTS ALSO PARTICIPATED IN THIS PROGRAM  
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